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The Challenge
Are you bored with the same old levels?    Can you crush critters in your sleep?    Then get

off the couch and create your own!    Use our level editor to challenge your friends and other 
Six Feet Under players; and if you think your levels are "killer" enough, E-mail them to us 
through AOL, CompuServe, or the Internet or upload them to our BBS and we'll give 'em a 
shot.    If we bang our heads against the wall, we will include your level(s) in Six Feet Under
version 2.00 (summer '95 release), and put your name in the credits!    The level(s) you 
designed will appear for all to attempt. 

We have plans to release at least 100 levels in version 2.00, so feel free to submit 
several entries. We will take the top 100 prior to release, so get your entry in soon!    Feel 
free to upload your levels (and the game itself) to any and all on-line service and BBS's.    
The level editor is free, and the unregistered version of the game can be used in conjunction
with the editor to play any level created.    If you do register the game now, you get access 
to all 50 levels, as well as the registered version of Six Feet Under 2.00.

Here are a few things to think about when designing your level(s).    

Make your levels easy to execute, but difficult to figure out, or turn the table and make 
them easy to figure out and "killer" to execute.    Consider a "theme" if you create several 
levels, such as:

1)    easy to complete kids levels
2)    mind-bending puzzler levels
3)    hand-eye challenging levels
4)    GIANT levels
5)    maze levels

...and the list goes on - be creative!

Don't feel like the level has to be overly complex or large to be good.    Some of the 
"baddest" levels are single screen.

Be creative; the more levels you create, the more "sinister" you become! 

Be sure the level can really be completed.    Testing you own levels is one of the toughest 
parts of creating really great levels.    Don't waste other's time by asking them to try to finish
an impossible level.

Create a "hints" file for your levels and send it to us or include it with your levels.



Overview
The level files for Six Feet Under (SFU) are plain ASCII text, and can be created or 

edited with any text editor, like Windows Notepad or DOS Edit.    However; editing the level 
files with a text editor can be painstaking and tedious.    Enter the Six Feet Under Level 
Editor.    The level editor is absolutely the fastest and most enjoyable way to modify or 
create new levels for SFU.    By using the actual game graphics the editor lets you see 
exactly how your level will look when running the game.    Add powerful cut, copy, paste 
and fill tools, and you have everything you need to spend less time on aesthetics and more 
time on puzzle logic.



Entrance

 

Each level has a position that marks where the player will begin.    The graphic of the 
man is used to mark this position.    To mark the entrance, select the man graphic from the 
graphic menu with the mouse and click on the desired point of entrance.    Each level must 
have one entrance.



Exit

 

Each level also has a position that marks where the player will exit the level.    The door 
graphic is used to mark this position.    To mark the exit, select the exit graphic from the 
graphic menu with the mouse and click on the desired exit point.    Each level must have at 
least one exit, but can have several.    The exit can also be either hidden or shown.    To 
toggle its attribute, click the mouse again on the exit.

Attributes:

Shown (no letter)
The exit is closed on level start.    The player must collect the required number of 
gems to open the exit.

Hidden (H)
The exit is open on level start, and looks exactly like a space.    No collected gems are
required to walk through this type of exit



Space and Dirt

 and 

 

 

 

 

 

Dirt is the most commonly used space filler for a level.    The player can freely tunnel 
through dirt objects, leaving empty space behind.    All inanimate objects will fall down the 
screen through space, and come to rest if they contact a dirt surface.    Dirt is primarily used 
to hold up objects, and give the player a medium to channel pathways for critters to follow.   
Creative use of dirt (I know, that sounds pretty silly) will increase the number of ways to 
interact with any given level.



Rocks

 

 

 

 

 

Rocks are inanimate objects that have sufficient mass to squash the player like rotten 
fruit.    They will fall through space until they strike any solid surface.    Rocks can be left-
leaning, right-leaning, or perfectly balanced.    For unbalanced rocks, if any space exists in 
the direction they lean, they will teeter and fall in that direction.

Attributes:

> (right leaning)
The rock will fall down and to the right if space is available.

< (left leaning)
The rock will fall down and to the left if space is available.

= (balanced)
The rock will fall down only.    Balanced rocks can be stacked as tall as desired.



Gems

 

 

 

 

 

In every level the player must collect the required number of gems to make the exit 
open.    Gems are like rocks in that they can fall on you with undesirable results.    They also 
will fall through space until they strike any solid surface and can be left-leaning, right-
leaning, or perfectly balanced. 

Attributes:

> (right leaning)
The gem will fall down and to the right if space is available.

< (left leaning)
The gem will fall down and to the left if space is available.

= (balanced)
The gem will fall down only.    Balanced gems can be stacked as tall as desired.



Barriers

 

 

 

 

 

 

 

 

 

 

Barriers are used to define the outer walls of the level.    They can also be anywhere in 
the level itself!    The player or critters cannot move through any of the barriers, unless the 
barrier is first destroyed with a bomb.    Of the ten barriers available, only the metallic 
barriers:

, 

 and 

 

are durable enough to withstand a bomb blast.    Use these barriers when you need an 
inpenetrable wall.



Critters

 

 

 

 

 

 

 

 

 

 

Critters all behave in the same fashion; they track through space, following the surface 
of all other objects.    If any critter gets within one cell of the player, its next move will be a 
hostile one, resulting in the elimination of the player.    Critters can be crushed by rocks, 
which causes them to explode into gems.    Nine gems will be created if the explosion occurs 
in either empty space or dirt.    Other objects directly next to the explosion can cause fewer 
gems to be produced (such as exploding next to a barrier).    Critters can also be destroyed 
by a bomb.



Bombs and Timed Bombs

 and 

 

Bombs are one of the most useful objects you can have in a level.    You can either place 
them in the level itself, or you may choose to have the player start up with any given 
number already in possession (see Settings).    

Timed bombs are bombs that have the fuse lit.    A timed bomb will explode after 1 to 9 
seconds.    When you place a timed bomb in a level, you may set its count down time by its 
attribute.    After the set number of seconds have expired, the bomb will explode.    When 
editing your level, simply click on the timed bomb to increment its count down.

When a player picks up a bomb, (even a lit one) he defuses it for later use.    When the 
player places a bomb, (to either the left or right by pressing [Space]), it is fused for three 
seconds.    At that point it is exactly like a bomb you placed in the level with an attribute of 3.

Attributes:

1-9 (seconds)
The timed bomb will explode in precisely the set number of seconds from the time 
the level begins.



The Sphere of Life

 

The sphere of life gives the player "an extra man" when picked up.    This gives another 
chance at any level in case the current man meets an untimely demise.



Clock

 

The clock object can be placed in a level to give the player more time.    For each clock 
the player picks up, ten seconds are added to the time remaining to complete the level.    
Clocks can be used in strategic places to force a player to go through whatever obstacles 
you design in order to obtain enough time to finish a level.



Lava

 

Lava can really add an element of panic to a level.    Lava grows through space and dirt 
until it fries the player.    Lava grows quickly through empty space, and more slowly through 
dirt.    Lava also has an attribute that sets the overall speed at which the lava grows.    It can 
be set to grow very quickly or more slowly.    Lava cannot penetrate barriers, rocks or gems, 
although it will fry a critter as readily as the player, so it can be manipulated to the players 
benefit.

Attributes:

0-9 (expansion rate)
The rate at which the lava will expand.    At zero the lava will expand over 10 times a 
second.    At nine the lava will expand about once every second.



Bonus

 

 

Bonus objects are items that give extra points when picked up.    They do not fall like 
rocks, so they can be counted on to stay at their set position until picked up.



Your First Level
The first step in designing your level is to choose a barrier and draw the four walls.    

Simply move the mouse cursor to the list of barriers and left or right click.    You will notice 
at the bottom right of the graphic menu the object you selected will appear under the Left 
or Right mouse button selection.    This is to show you what object you have assigned for 
painting with that button.    Now use that object to draw the four walls by "painting" with 
the mouse button in the level window.

Next you should choose a place for the exit.    Simply select the exit icon from the grapic 
menu and click to place it in the level.    This is the door through which the    player will walk 
to exit the level.    You can have one exit, or you can have several.    For this tutorial, lets 
place one.    Move the mouse cursor to the center of the right wall and click.

Next we will choose an entrance for the level.    Select the man icon from the graphic 
menu and click somewhere in the left side of the level.

Now we will give the player something to pick up.    Select the ruby icon and click 
anywhere within the four walls.    Do the same with the other four gems such that you have 
all five gems within the level.

The last step is to save the level.    Go to the File menu and select Save As, type in the 
name for your level (like MYLEVEL.TXT) and click on Ok.    You will notice the name of your 
level now appears in the title area of the level window, along with the size of the level 
defined by the barriers you drew in the first step!

Now we are ready to test the level.    Click on the test menu and the level will begin.    
Move the man to pick up each gem (they may fall first if you placed them in empty space).    
You will notice that after the fifth gem is collected the exit will open.    Walk through the door 
to end the level and return to the editor.    You may also return to the editor at any time 
during level testing by closing off the window.



The Sample Levels
Many times the best way to learn is by example.    We have included several levels with 

the editor to get you started doing just that!    Simply open each level with the editor 
(Select Open from the File menu), click to back up one directory, and select one of the .TXT 
files.    When the level comes up, examine the contents.    Then click on the test menu 
selection to play the level and see how the objects behave.    Feel free to modify the level 
and play it again to see what your changes did to make the level different.    Don't be afraid 
to experiment.    Many of the best effects are discovered by accident!



File Menu Commands
New

Select this command to begin editing a new level.    The level window is cleared and the 
filename set to untitled.

Open
Select this command to open a existing level file for editing.

Save
Select this command to save a level file to disk.    If the level file is new, you will be asked 
for a file name.

Save As
Select this command to save the current level to any file name.

Exit
Select this command to exit the editor.



Edit Menu Commands
Undo

Select this menu item to undo the last operation performed.

Cut
Select this menu item to cut a region from the level window to the clipboard.    The region 
will be cleared to blank space.    The mouse icon will turn from the arrow cursor to scissors
to indicate you may click and drag the mouse to specify the region to cut.    When finished
the cursor will automatically switch to paste.

Copy
Select this menu item to copy a region from the level window to the clipboard    The region
will remain unchanged.    The mouse icon will turn from the arrow cursor to scissors to 
indicate you may click and drag the mouse to specify the region to copy.    When finished 
the cursor will automatically switch to paste.

Paste
Select this menu item to paste in a region cut or copied to the clipboard.    The mouse icon
will turn into a paste cursor to indicate you may click on the point (top left corner) to start
the paste.    When finished, the cursor will automatically switch to paint.



Tool Menu Commands
Paint

Select this menu item to enter paint mode.    Use the left or right mouse button to "paint" 
objects into the editor window.    You may hold down either mouse button and move the 
mouse, or you may single click to drop each object.    Use the left and right mouse buttons
on the graphic object menu to select an object for painting.

Fill 
Select this menu item to enter fill mode.    Click the mouse on each area to fill.    All cells 
with the same object will be filled with the current draw object.

Fill Vertically
Select this menu item to enter fill vertical mode.    Click the mouse on each column to fill.   
All cells in that column with the same object will be filled with the current draw object.

Fill Horizontally
Select this menu item to enter fill horizontal mode.    Click the mouse on each row to fill.    
All cells in that row with the same object will be filled with the current draw object.



Option Menu Commands
Settings

Select this menu item to pull up the settings dialog box.    These parameters set the WAV 
files used for the sound effects for the level, the MIDI file for background music, and 
elements such as time allowed for the level, the number of gems needed to collect before
the exit will open, and any bombs that the player will have when the level begins.    The 
level title that is displayed during game play may also be entered.

 

View 1x
Select this menu item to view the level at full size.    This is the maximum level of zoom.    
Attributes are only shown in View 1x mode.

View 4x
Select this menu item to view more of the level.    This allows four times the area of the 
level to be viewed over View 1x.

View 16x
Select this menu item to view very large levels.    Sixteen times the area is shown over 
View 1x.

Show Attribute
Select this menu item to toggle the display attribute.    The display attribute is a text 
character that indicates more information about the object that is in the cell.    For 
example, gems and rocks can be left-leaning ( < ), right leaning ( > ), or perfectly 
balanced ( = ).    Lava has a digit (0-9) indicating the speed at which it grows, and timed 
bombs have a digit (1-9) to indicate the number of seconds until they explode.    To set an 
attrribute, first be sure this menu item is checked, and then click on the cell to toggle the 
attribute for the item.    If no text is shown in the cell, then no attribute is available.



The Test Menu
Test

Select this menu item to save the level and test the level in the game itself!    After a 
moment Six Feet Under will begin with the level.    To return to the editor, simply close the 
game, or finish the level and walk through the exit.



The Help Menu
Contents

Select this menu item to get help on using the editor.

About
Select this menu item to see information about EnQue Software.



If you have enjoyed playing Six Feet Under, and would like to register the game, just 
send $15.00 to:

EnQue Software
25700 East 203rd Street
Pleasant Hill, MO    64080

FAX/Voice: (816) 987-2515
24-hour BBS: (816) 566-2956

E-mail Addresses: KHuck116@aol.com or DrBoyd@aol.com

If you wish, you may register the game by VISA or MasterCard.    Simply FAX, E-mail, or 
call our 24-hour BBS.    Please include your full name, card number, expiration date, 
shipping address and Six Feet Under serial number.    Your Six Feet Under serial number can 
be found under Gold Key in the Help menu of the game.    You may also register by check 
or money order, and then wait for our speedy postal service to do their job.    For your 
convenience,    we have included an order form that you can print out and mail in.    Just 
click on order form,  go to the File menu and select Print Topic, or simply jot the 
information down on a sheet of paper.

Once we receive your registration fee, we will provide the gold registration key that 
unlocks all additional levels.    If you wish, we will also put you on our mailing list to receive 
new games as they becomes available.



Six Feet Under Order Form
EnQue Software
25700 East 203rd Street
Pleasant Hill, MO    64080

FAX/Voice: (816) 987-2515
24-hour BBS: (816) 566-2956
E-mail Addresses: KHuck116@aol.com or DrBoyd@aol.com

Here is my $15.00.    Please send me the gold registration key for Six Feet Under.    My serial
number    is ______________.

[      ]
Yes, I would like to be included on your mailing list for the next version of Six Feet Under.    
Also please send any new games as soon as you release them.

[      ] 
No, I would not like to be included on your mailing list, but please send the gold registration
key.

Name:      ___________________________________________

Address:    __________________________________________

City: _________________________________    State: _______

Zip: __________-________    Country: ____________________

[      ] Visa                                Number:______________    Exp Date:_____ 

[      ] MasterCard        Number:______________    Exp Date:_____

[      ] Check or Money Order




